CIA Form Modification Guide
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1. General Information and Software Requirements

This guide is written in a way to allow Section 1 and Section 2 to be given to a customer in case any
issues arise with the CIA form.

1.1 Software Requirement
e Recommend to customers the use of Adobe Acrobat Reader to fill out the form to ensure the
best user experience. The software is free to download and use.
e To make modifications to the form template, Adobe Acrobat Pro is required.

1.2 General Information and Basic Navigation

Adobe Acrobat Reader and Adobe Acrobat Pro have a similar layout and user interface, but Adobe
Acrobat Pro has some additional modules. One of these modules is the “Prepare Form” module, which
is required to create and modify the CIA form.

At the end of this guide, you will become more familiar with the following modules:
Customer Tools:

e Fill and Sign: This module is used by the client to fill and sign the form

e Stamp: used by customer to create a stamp (example: P. Eng. Stamp)
Form Editor Tools

e Edit PDF: Used to edit the layout of the form fields and text that appears above or beside the
form fields.

e Prepare Form: where all of the JavaScript coding is written for each form field. This module is
used to create radio buttons, check boxes, lists, and the formatting for the type of input
required for each field, etc.

e Organize Pages (optional): This is not required, but can be used to add templates, such as
creation of the Add Page button on page 8 of the CIA form. It is considered beyond the scope of
this guide.

To access these modules:

Open the document in Adobe Acrobat Pro (or Adobe Reader)—> Tools = [choose required module]

File Edit View Window Help

Home Document B Bd Q @ 1 /16 @ a&
Document

@ /E Hydro

Connection Impact Assessment (CIA) Application

C department's name that is handling the applicatien] | [LDC department's email] | [LDC department's phene Number]

» ABOUT THIS FORM

Thisc CAannamtiann Innmneaat Acsacaman 1A mnnlinatian ic 3a ha camnlatad b e cananant intarastars

The modules appear both as an icon view (on the left) or a list view (on the right). | recommend the
icon view because the list view at times hides some of the modules/tools. Select the required module.
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Home Tools Document

Q lSearch Tools...
Create PDF

Open | ¥

Comment

Open | ¥

Protect

CJ
0=

Edit PDF

Open | v

Organize Pages

Open | ~

Fill & Sign

S

Export PDF

Open | v

Enhance Scans

Open | v

Prepare Form

ﬁ Create PDF
5= Edit PDF
3 Export PDF
Comment
|| Organize Pages
5

= Enhance Scans

> O Protect

A Fill & Sign

@ Prepare Form

Note: Pressing “Document” tab above returns the user to the document (CIA form) if no module

selection is required.
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2. The Customer Experience

2.1 General Information about the “Fill and Sign” Module
Adobe has an easy user experience for the customer when it comes to filling out the form.

To verify all required fields are filled and for help with placing signatures, this form is equipped with
features to guide the customer along.

e The document automatically launches in the “Fill and Sign” module where the customer is able
to both fill the document and electronically sign it. More on this in later. The customer can
begin filling out the form immediately without any understanding of the various Adobe
modules.

e We also added the following features to help the customer:

o Validate Form: ensures all required items are filled out by the customer

o Clear Form: Resets all of the form fields (to blank) to ensure old information from a
different project are not accidently used

o “Ilmportant Notes” discusses what the customer is expected to do

® & Hydro

Connection Impact Assessment (CIA) Application
Hydro Ottawa Limited / Hydro Ottawa limitée | DER@hydroottawa.com| 613-738-5499 x 7312

Validate Form

p ABOUT THIS FORM Clear Form

This Connection Impact Assessment (CIA] application is to be completed by any proponent interested i
connecting a Distributed Energy Resources [DER) with a project size over 12 kilowatts (kW) to Hydro Ottawa
Limited (HOL). This includes DER applying for a new CIA or for revision(s) to their original CIA. This form
expresses an intent fo enter into an agreement between HOL and the customer [or host customer* for non-
exporting projects| for completion of a CIA associated with connecting a DER to the HOL's distribution grid. The
ClIA Application shall be part of the required servicing (electrical installation, maintenance, and operating)
agreements between HOL and the proponent. Through this process, HOL will be the propenent’s contact with
the transmission system provider [e.g. Hydro One Neftworks Inc.) and, if necessary, the provincial market

operator, namely, the Independent Electricity System Operator (IESO).

*For non-exporting projects, the term “host customer” refers to the owner of the load facility. The term "DER
owner” refers to the owner of the DER facility.

Emergency Backup Generators should use the Emergency Backup Generation Application Form available at:
ECG UO%: Technical Guideline For Customer Owned Standby generorion

p TECHNICAL REQUIREMENTS

For technical requirements of HOL's DER projects, refer to the ECG0006: “DER Technical Interconnection
Requirements Interconnections at Voltages 50kV and Below”.

p SUBMISSION INSTRUCTIONS

Please return the completed form, fees and other required documents by mail to:

Hydro Ottawa Limited / Hydro Ottawa limitée
Attn: DER

2711 Hunt Club Road, PO Box 8700/chemin Hunt Club, C.P. 8700
Ottawa, Ontario K1G 354 (for mailing) or K1G 5Z9 (for courier)

» IMPORTANT NOTES
- An engineering stamp and all red box fields (on electronic version of form) are mandatory. Incomplete
applications may be returned by HOL and will result in delays in processing your application. Click the "Validate
Form" button on the top right of this page to ensure all required information is filled. If any of the required fields
are not applicable o your project, type “N/A" in any required text field or “0" in any required numerical field
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2.2 Form Validation

2.2.1 The Validate Button

This button, found on the top right corner of page 1 of the CIA form, checks for any required fields
(outlined in red). The picture below shows examples of required fields, optional fields, and read only
fields.

e Required Fields: the customer must fill these fields. Checked by the “Validate Form” button to
ensure completion. They appear as a blue box/radio buttons and outlined in red.

e Optional Fields: These fields are helpful to the LDC, but are not necessary for completion of
evaluation. They appear as a blue box/radio buttons.

e Read Only Fields: These fields are greyed out to the user based on other selections made in the
form. They appear as white boxes/radio buttons.

For certain application type selections, please complete the required fields:

Qriginal CIA Project ID #

Revised Fields

» SECTION B: PROJECT LOCATION

Address
City /Town / Township Postal Code
Lot Number(s) Concession Number(s)
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2.2.2 Validation Results
When pressing the “Validate Form” button, one of three messages is presented to the user:

Message 1: if 10 or more required fields are missing:

T Validate Farm

Warnine: JavaScript Window - Clear Form

d in
. You have 10 or more required fields that need to be populated. Please fill out all hi
' fields outlined in red, name], This
intent to enter
projects) for

Applicatien
his between
JPV"U"N; ll"vut‘lll LLLLEJ P'V\aﬁ\,.’) LLIJ\_» v.vuv"c} A AL "4 10 L1 ’J"-Ll‘?.’u']c"‘ A4 A LA™ 1" B 4 Ith the

B | e e e e e e e ]

S L s Ll .

Maessage 2: less than 10 missing fields. The form specifies the missing fields:

Warning: JavaScript Window - Form Validation Results

Warning! Please populate the missing required fields listed:
Section K: DER Type - Qther
Section S: Mearest Pole Nurmber

Maessage 3: If all required fields are populated. An information message is shown:

{ !
. pt - Form t R t I
f
| 0' Well done. There are no major errors detected by the form. t
{ = }
)
i oK
5
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2.3 P. Eng. Stamp and Digital Signature

Once a stamp and signature are created, adding them to the document is a simple two-step
process that should take less than a minute. The form assumes the customer has no prior
experience with this process, hence, a step-by-step guide is provided in the form.

» SECTION A: APPLICATION INFORMATION

Engineering Stamp Application Type choose one Date mm
@ —
INew CIA Application |
Program Type/Purpase choose on Program Type (additional details)

INon-exporting

Project Name

- IESO Contract NUmber  Foorxss-x-x-xxx IESO Reference Number Aim-xcooos

Ontario Corporate Number or Business Identification Number Proposed In Service Date mm/dd/yyyy

If this project is a subdivision project, please complete the following fields:

Subdivision Project Name Number of Lots

For certain application type selections, please complete the required fields:
Original CIA Project ID #  x00

Revised Fields st the fields that hav

When the user clicks on the question mark, the following message appears to guide the user:
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Warning: JavaScript Window - Engineering Stamp and Electronic Signature

| '0 The following is a general guideline for applying an electronic P. Eng stamp and signature.
J The steps vary slightly for Adobe Acrobat Reader/Pro). Note the 'Engineering Stamp' field is
broken down into (1) The stamp and (2)the signature/date areas.

Step 1: Creating a Stamp in Adobe (only needs to be done once):

1.1 Scan your stamp (in accordance with PEO guidelines).

1.2 Crop the stamp and save the image as a pdf (recommended), jpeg, or png.

1.3 In the Tools' tab, choose the 'Stamp' module.

1.4 From 'Stamp' module, choose 'create’ under the ‘Custom Stamps' menu.

1.5 Find the custom stamp created in step 2 and confirm the selection. The next screen

allows you to name the step and choose a category. The category should be 'Business
| Standard'.

Step 2: Applying the P. Eng Stamp:
' 2.1 Open PDF file to be stamped.
l 2.2 In the Tools' Tab, choose the ‘Stamp’ module.
2.3 Locate the stamp created under the 'Stamp’ menu. The stamp is saved in the ‘Business
Standard' section.
2.4 Resize the stamp to fit in the square box provided.

| Step 3: Applying the Digital Signature (makes document read only):
3.1 After filling the entire document, click on the signature space under the stamp created
above.
3.2 If you have a signature created, choose it, otherwise, follow Adobe's instructions on
I creating a 'digital ID". The type of ID chosen is optional.
3.3 Once applied, save the document. All fields are now read only. If you require future
changes, you have the ability to right click on the signature and 'clear signature’.

QK

Below are some of the steps shown:
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Access the “Stamp” module as described section 1.2. Below are some screenshots from some
of the steps above

The menu appears as follows in Adobe Acrobat Reader 2017:

Step 1.3: The Stamp module/tool

Stamp ~ & Stamp ~ & Stamps Palette & Custom Stamps ~

Step 1.4: create a new stamp

& Stamp - ,2-’ Stamps Palette 'Sil Custom Stamps -
Create... %

Manage...

Step 1.5: choose “Standard Business” in Category (The “i” image in this demo would be
replaced by a P. Eng stamp image that is scanned).

Create Custom Stamp X

Category: ‘Standard Business v

—le

Name: |Samp|e Stamp

Down sample stamp to reduce file size

Select Image for Custom Stamp...

Help oK Cancel
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Step 2.3: Stamp —>Standard Business = Select the stamp (P. Eng Stamp) created in step 1.5

Stamp ~ & Stamps Palette & Custom Stamps

APPROVED

Dynamic
Sign Here

Standard Business

Add Current Stamp To Favorites

Show Stamp Names

Paste Clipboard Image as Stamp Tool

e el R

[ESO Contract Number

Step 2.4: resize stamp to fit stamp area

Engineering Stamé)
0 ‘

] @ Application Type

FINA
CoM

’

CONFI
FOR PUB
NOTFORP

’

FOR C(

—_—

VOID
PRELIMIN

INFORM

Date

New CIA Application

Program Type/Purpose

Non-exporting

Project Name

Program Type (additional detalils)

IESO Contract Number

IESO Reference Number

\
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Step 3.1:

b SECTION A: APPLICATION INFORMATION

Engineering Stamp Application Type Date
@ New CIA Application <
. Program Type/Purpose Program Type (additional details)
Non-exparting <

Project Mame

IESO Contract Number IESO Reference Number

T ©

Ontario Corporate Numbergel

blimber Proposed InService Date

Section A: Digital Signature

(Click to sign)

Step 3.2: This is a certificate issued by me. Other more secure methods can be used, but not
required for the CIA form submission. Adobe guides the user with the creation process.

| Sign Document X

Sign As: tSamer Matti (Samer Matti) 2025.11.13
Issued by: Samer Matti More Detail

Appearance: }E’;indard Text
Digitally signed
Samer by Samer Matti
- Date: 2020.11.16
Mattl 1:18:37 -05'00

Click Review to see if document content

may affect signing Review...
Enter certificate password and click the 'Sign’ button
REAXEAREAAER
Help Sign Cancel
10
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Step 3.3: the resulting document is read-only with the digital signature and stamp applied

Engineering Stamp
@ Application Type

New CIA Application @
Program Type/Purpose

Non-exporting =

Project Name

IESO Contract Number

Digitally signed by Samer

Sa mer M atti g‘:tt: 20201118 11:22:47

-0s'ao0*

11
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3. Preparing the Form

3.1 The “Edit PDF” Module
This module is required to edit the layout and text that appears in the form. Access this module
as shown in section 1.2.

IMPORTANT NOTE: prior to making any edits, please create a backup copy of the document.
Also, save the file frequently. Adobe Acrobat Pro can crash or cause unintended changes that
are hard to recover at times. It is advised to create backup copies along the way if making any
significant changes.

You will require the use of this module when changing all of the red text to match your
company’s information:

Example:

Connection Impact Assessmen FORMAT

[IDC deparmert's nare thal iz hardling the applicstien] | [LBC demardmeal's e o; [LDC name]
ABOUT THIS FORM

T is Connection Impact Assessment (CIA) app ication is to be]
cennecting a Distributed Energy Resources (DER] with a projg
includes DER applying for a new CIA or for revision{s) to the

FuturaBook

1002 ~ .

into an agreement between IDC ame] and the customer (of

Replace with

cempletion of a CIA associated with connecting a DER 1o the]

-]
~
H
=
by

shall be part of the required servicing {electrical installation,
[IDC name] and the proponent. Through this process, [LDC Hydro One

transmission system provider {e.g. Hydro One Networks Inc ]
namely, the Independent Electricity System Operator (IESO).

*For load Displacement projects, the term “host customer” rs
owner” refers to the owner of the DER facility.
Emergency Backup Generators should use the Emergency Backup woene dlien Appiicalion 1o

[LDC link to application] - - v
T 9981~ AV 0

1 [ ]
TrALIAIAAL DrAIIIRCFAAFAMTS I A

In the example above, “[LDC name]” is being replaced with “Hydro One”. On the right side, the
FORMAT section should be used to change the text that appears in red to black.

The resulting change:

Find

Connection Impact Assessmen FORMAT
[LEC deparment's nawe that iz handling the application] | [LBC desartmenl’s era [LDC name]

AROLUIT THIS FORM . FuturaBook
"5 onnec on mpac ssessmen app ica on i1s o b

connecling a Bistributed Energy Resources [BER) with a projg

10.02 .

includes DER applying for a new CIA or for revision{s) to the

into an agreement between  dro One and the customer {o

Replace with

completion of a CIA associated with connecling a DER to the]

-
N
H

shall be part of the required servicing {electrical installation,
[LDC name] and the proponent. Through this process, [LBC r Hyd\r'() One
transmission system provider {g.g. Hydro @ne Networks Inc
namely, the Independent Electricity System @perator [[ES®).

*For Lload Wisplacement projects, the term “host customer” r4
ra men ol e
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3.2 The “Prepare Form” Module
This module is required to create/modify form fields. Access this module as shown in section
1.2.

IMPORTANT NOTE: prior to making any edits, please create a backup copy of the document.
Also, save the file frequently. Adobe Acrobat Pro can crash or cause unintended changes
(especially in the this module) that are often hard to recover. It is advised to create backup
copies along the way if making any significant changes.

The best way to understand how these fields work is to double click an existing field.

Taking a look at a sample field from CIA form’s Section A:

Proposed InService Date

_P ro pSewice Date-

+ following fields:

The first tab is the “General” information section:

General Appearance Position Options Actions Format Validate Calculate

Name: |propServiceDate

Tooltip:  [>ection A: Proposed In-service Date

Common Properties
Form Field: | Visible h []Read Only

Orientation: 0 degrees Required

[ ]Locked Close

13

\

4 Hydro



Name: the “variable name” that the coding is based on. Example, if a certain variable is true
then do this. You can see this in action shortly in section 3.2.1.

ToolTip: this is the text that shows up in the validate button. It lets the user know where they
missed a field. The validate button searches for the “required” fields, which can be seen in the
bottom right side of the general tab. Note that the “read only” and “required” can either be set
in this “General” tab or they can be based on conditions in the “Action” or “Calculate” tabs.

The “Appearance” tab allows you to choose things link font, colour, and text size.

The “Format” tab allows you to choose the format of the field, such as date format, number
format, text field, etc.

3.2.1 Example using JavaScript (in “Prepare Form” Module)
Let us look at the Existing Project Number from CIA form’s Section E:

The “Existing Project Number” is only available if there is an existing DER at the PCC. Hence,
the answer to the first question determines if the “Existing Project Number” is required.

» SECTION E: EXISTING DER
Are there existing DER at the point of common coupling (PCC)?

@ Yes No
Existing Project Number

existingQER

Double click on the “existingDER” field and navigate to the “Calculate” tab. Choose “Edit..."”:

14
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General Appearance Position Options Actions Format Validate Calculate

(O Value is not calculated

() Value is the sum (+)

O Simplified field notation:

(® Custom calculation script:

else{
event.target.required = false;
event.target.readonly = true;
event.target.value = "*;

}

[ ]Locked

15
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Edit...

Edit...

Close
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This is the code that appears:

if(getField("existingGenerator").valueAsString === "yes"){
event.target.required = true;
event.target.readonly = false;
}
else{
event.target.required = false;
event.target.readonly = true;

event.target.value ="";

}

Part of Code Explanation
existingGenerator Notice “existingGenerator” is the variable name that determines
the condition.

existingGenerator would be the “Name” in the general tab for that
particular field, which is being used here to determine if this
“existingDER” field is required or not (read only). Reading further
below will make this more clear.

event.target.required = | Sets the field as required.

true
event.target.readonly | Sets the field as a fillable field (not read only)
= false

Putting it all together, the code above looks at the question above that reads “Are there
existing DER at the point of common couple (PCC)? Yes or No.

If “yes” is selected, the existingGenerator value is set to yes (will be shown below). When that
condition is true, Existing Project Number (assigned the variable “existingDER”) is required to
be filled via “event.target.required = true;”, hence it will be checked by the “Validate Button”
and “event.target.readonly = false;” makes sure that the field is available for data entry (not
greyed out).

Otherwise (via the “else” statement), If “no” is selected, the existingGenerator value is set to no
(will be shown below). When that condition is flase, Existing Project Number (assigned the
variable “existingDER”) is NOT required to be filled via “event.target.required = false;”, hence it

16
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will NOT be checked by the “Validate Button” and “event.target.readonly = true;” makes sure
that the field is greyed out and NOT available for data entry.

For completeness, here is how the “existingGenerator” variable’s value is passed on to the code
above:

» SECTION E: EXISTING DER
Are there existing DER at the point of common coupling (PCC)?

@ Yes @ No

The radio buttons above both have the variable name “existingGenerator”, which can be seen
when enlarging the field or in the “general” tab:

Are there existing DEI

or

General Appearance Position Options Actions

Name: ’existingGenerator

Tooltip: Section A - Existing Generator

Common Properties

Form Field: | Visible N (] Read Only

Orientation: degrees Required

[J Locked e

17
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Navigating to the “Options” tab for the “yes” radio button:

General Appearance Position Options Actions

Button Style: |Circle v

Radio Button Choice: [Y€5

[ ]Button is checked by default

[ ] Buttons with the same name and choice are selected in unison

Note that the radio button choice is case sensitive. Since it is lower case here, it must be typed
exactly the same way in the code shown for the existingDER on page 17. If the “no” radio
button is selected, that radio button’s “Radio Button Choice” is programmed to “no”. Since
both radio buttons have the same variable name (“existingGenerator”), the software only
allows one button to be selected at one time.

18
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